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Description and Objectives

Course Description

As you move into Sheeting Composition stage, a pain that you may encounter is that laying out drawings onto sheets is a time consuming and 
error-prone process that is done differently by everyone on a team and can cause inconsistencies and delays in getting projects delivered. 
Fortunately, with the new innovations found in MicroStation’s CONNECT edition’s Documentation Center, the solution is the Accelerated 
Sheet Creation and Layout. Here you can create multiple sheets in a single operation. The Automated layout can be based on scale, location 
and along path. Once generated, the Sheet layouts can be modified for fine adjustments.

Skills Taught

 Creating Named Boundaries

 Placing Cells

 Placing Named Boundaries using the, 
By 2 Points method

 Adjusting the extent and positioning of a 
Named Boundary

 Creating Drawing Boundaries

 Attaching a Raster Image

 Manipulating a Raster Image

 Creating a Sheet Index

A similar type of workflow is available in AutoCAD through the Layout tools.



Before You Begin...

Milestones

The exercises are meant to be performed in the sequence as they appear in this workbook or as individual standalone exercises. You can 
start at any exercise within a subdirectory of the dataset called Milestones. There are files named for each individual exercise, and you can 
begin by using that particular file. Copy the desired milestone file(s) into the dataset’s root folder to begin.

Workflows

The exercises contained in this workbook are designed to follow a specific workflow called LEARNing CONNECT. This workflow is set via the 
Workflow toolbar. The purpose of the LEARNing CONNECT workflow is to simplify the menu choices for the new learner. You may also use the 
standard Drawing workflow. The location of the Ribbon Tabs, Ribbon Groups and Tools are identical for both workflows.

Compatibility Notes

Where applicable, this workbook contains “compatibility notes” intended to assist in the transition to MicroStation from AutoCAD. These notes 
are formatted to stand out from other text in the body of the document. 

Compatibility notes are formatted as illustrated:

This is an example of a “compatibility note” found in a Bentley training document.

AutoCAD and RealDWG are trademarks or registered trademarks of Autodesk, Inc. All other brands and products are trademarks of their 
respective owners. These training materials may be used for informational and educational purposes only. 
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The Training Dataset

Training Dataset Installation Instructions

Note that the exercises contained in this workbook are designed to use a custom WorkSpace, BentleyCONNECTTraining, and the WorkSet 
MSBasicsCivil. The default installation folder for this dataset is:

C:\BentleyCONNECTTraining\WorkSets\

For instructions on how to configure a training dataset, please visit Learn.Bentley.com and view the following training course:

Before You Begin: Configuring a Dataset for a MicroStation CONNECT Edition Course
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Place Named Boundary

At this point in the project, you are finished with the design composition of the proposed building. Where-as you move 
into the View Composition stage where you then compose all the desired views (sections, plan views, etc.) in the 
project. And then from there, the Sheet Composition stage is where you create sheets that represent finished work, 
ready for publication. In this section, you will use the Place Named Boundary tool to rapidly place the contents of design 
onto a new sheet. The following features are covered:

 Creating a Named Boundary

 Rapid Sheet Creation via Dynamic Views

Exercise End Result

A Sheet model in MicroStation is similar to the Layouts in AutoCAD.
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1. Begin by opening the Proposed Site Plan.dgn from the 09 - Composing Sheets.

2. Make the DrawingBoundaries level active via the Level Picker (Home > Attributes).

3. Along the ribbon, from the Named Boundaries group of the View tab, select the Place Named Boundary tool. 

A named boundary is any closed element that has a name associated with it. Previously, you could create named fences from fences, clip 
volumes, and clipped masks. Named fences have been renamed as named boundaries. 

While not exactly the same, the AutoCAD Boundary tool provides some similar functionality.

4. Set the following options in the tools settings window:

 Method (icon): From Drawing Boundary

 Drawing Boundary: Plan_SheetOnly

 Name: Proposed Site Plan

 Detail Scale: 1”=20’

 Mode (icon): Place a Single Named Boundary

 Create Drawing: Enabled



Copyright © 2016 Bentley Systems, Incorporated 7DO NOT DISTRIBUTE - Printing for student use is permitted

5. Bring your cursor into the view, however, do not issue a data point. Rather, observe the rectangle attached to your cursor. 

The rectangle’s aspect ratio is being controlled by two factors. The first being the Drawing Boundary that you selected. A Drawing 
Boundary is a predefined area on a sheet model. In this case, the Plan_SheetOnly drawing boundary is being read from the Design 
Library (dgnlib).

Another factor controlling the aspect ratio of the drawing boundary (rectangle) is Detail Scale, which is currently set at 1”=20’ in the tool 
settings window. 

6. With the Place Named Boundary tool still active, hover the drawing boundary over the proposed site and observe the result.

The drawing boundary at the given detail scale in not big enough to encompass the whole site. That being said, you need to adjust the 
detail scale in the tool settings window.

7. Back in the tool settings window, set the Detail Scale to 1”=40’.

8. Bring your cursor back into the view and now observe the results of changing the detail scale. Clearly, this large enough to fully 
encompass the site and surrounding existing features adjacent to the proposed site.

9. Bring your cursor to the left of the Crill Ave (SR 20). With the proposed building centered visually within the drawing boundary, issue a 
data point.

Hint: You can snap to the mid-point of the rear of the existing one story block house.
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Immediately, Create Drawing dialog opens. The Place Named Boundary tool is the latest part of the Dynamic Views portfolio of tools -- 
which goal is to make model analysis and documentation more interactive and intuitive with the ability to create live, intelligent views of a 
design that update automatically as the design evolves.

10. Ensure the following options are set in the Create Drawing dialog:

 Name: Proposed Site Plan (name of saved view)

 Drawing Seed: Plan_SheetOnly

 Create Sheet Model: Enabled

 Sheets: New

 Annotation Scale: Full Size 1 = 1 (scale factor of sheet)

 Drawing Boundary: Plan_SheetOnly

 Detail Scale: 1”=40’ (scale factor of reference)

 Add to Sheet Index: Enabled = select the 02 - Plans folder

 Open Model: Enabled

11. Click OK when finished to generate the Proposed Site Plan sheet.
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The sheet opens with the contents of the named boundary referenced. The sheet seed from the Design Library (dgnlib) used to generate 
this Proposed Site Plan Sheet contained a drawing boundary. The area that was designated is where this named boundary was spatially 
placed onto this sheet. Otherwise, the named boundary would have been placed centered on this sheet.

Also as part of the creation of the sheet with your proposed building referenced to it, this was included into the Sheet Index. A sheet index 
is a centralized and structured collection of sheets in your project. Sheet index can be useful in creating a construction document set (also 
called as sheet set or construction set) that contains all the sheets of your project. You can view the sheet index from the Explorer dialog.
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Labeling the Plan Sheet

In most cases, plan sheets are embellished with sheet specific annotation such as but not limited to -- text, dimensions 
and cells. All of which is placed tied to the scale of the sheet. In this next section, you will place a north arrow and bar 
scale. You will also apply the Display Style, Proposes Site Plan, that you created earlier. The follow features are 
covered.

 Placing Cells

 Applying a Display Style

 Updating a Saved View definition

The Block command in AutoCAD is similar to the Place Cell command in MicroStation.
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1. Continuing in the Proposed Site Plan.dgn, with the Proposed Site Plan Sheet model active, make the Place Active Cell active (Annotate 
> Cells).

2. In the tool settings window, click the Browse button.

3. The Cell Library dialog opens. From here, click the File menu and then select Attach File....

4. Navigate to the \BentleyCONNECTTraining\WorkSets\MSBasicsCivil\Standards\Cell folder, select the Roadway.cel and then click 
Open.

5. Scroll the list of cells and then double-click the Scale Bar 1-40 cell.

6. In the tool settings window, make sure that Active Angle is set for 0.0 and that both X and Y scales are set to 1.

7. Place the Scale Bar 1-40 cell in the open space of sheet in the lower-right corner, just above the title block area. Reset when completed.
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8. Next, hover your mouse over the yellow marker along the left-side of the border. 

9. As you do this, a mini-toolbar will appear. Move your cursor onto the mini-toolbar and select the icon, Open Design Model. 

The Proposed Site Plan design model opens. This is were the named boundary definition exists. From here, you will un-rotate the view 
and place a north arrow.

10. Along the View Control toolbar, select the Rotate View tool.

11. Make the Place Active Cell active (Annotate > Cells).

12. Next to the Active Cell field of the tool settings window, click the Browse button and select the North cell from the Cell Library.

Hint: If you know the name of the cell that you wish to place, simply type the name into the Active Cell field.

13. In the tool settings window, make sure that Active Angle is set for 0.0 and that both X and Y scales are set to 1.

14. Place the North arrow into the un-rotated view (this ensures that north is oriented in the upward direction) in what is now the upper-left 
corner of the named boundary. Reset when completed.

15. Next, click the View Previous button from the View Control tools enough times that the view restores back so that the named boundary is 
parallel to the screen once again.
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16. You need to navigate back the sheet model. Just like you did before, hover your mouse over the marker to make the mini-toolbar appear. 
Then, click the Open Target icon.

You are returned to the sheet model. Next, you will apply the Display Style that you created earlier. However, you can not simply apply this 
through the View Attributes dialog or Display Styles dialog like you did earlier. The reason being is that as part of the Dynamic Views 
workflow, the Place Named Boundary created a Saved View. And this Saved View determines what display style to use. So, in order to 
change this, you need to update the Saved View definition.

17. Open the References dialog (Home > Primary).

18. Right-click on the Proposed Site Plan reference. From the contextual menu, select Presentation.

19. The Reference Presentation dialog opens. From here, click into the Display Style drop-down menu and select Proposed Site Plan. Click 
OK when finished. 

20. Save Settings (File > Save Settings).
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The Saved View definition has been updated to use the Proposed Site Plan display style. If you recall, you created the display style in this 
dgn file. Ideally, you or the CAD Manager would create display styles in the Design Library. That way the display style, just like other 
resources like levels for instance, would be available project-wide for all the dgns that you work within. 

Furthermore, the Drawing Seeds, which are used as part of the Dynamic Views workflow, could then utilize these display styles. Hence 
automating the workflow even further.

Alternative Display Styles are available in AutoCAD through Visual Styles.
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Placing a Named Boundary

A named boundary is any closed element that has a name associated with it. Previously, we could create named fences 
from fences, clip volumes, and clipped masks. Named fences have been renamed as named boundaries. You can 
place named boundaries using drawing boundaries. Named boundaries may also be grouped for processing sets of 
drawings onto sheets.

In this section, you will create a Named Boundary and it will place the content of the Named Boundary onto an existing 
sheet model. The following features are covered:

 Placing a Named Boundary using the, By 2 Points method

 Adjusting the extent and positioning of a Named Boundary
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1. Begin by opening the Site Plan Details.dgn file from the 09 - Composing Sheets folder.

2. From the Models dialog (Home > Primary). make the Manhole Frame and Cover model active by double-clicking it.

3. Make the level DrawingBoundaries active via the Level Picker (Home > Attributes).

4. Along the ribbon, from the Named Boundaries group of the View tab, select the Place Named Boundary tool.

5. Set the following options in the tools settings window:

 Method (icon): By 2 Points

 Name: Manhole Frame and Cover

 Mode: Place Single Named Boundary

 Create Drawing: Enabled

6. You are prompted to enter the first point. Issue a data point (left mouse click) up and to the left of the Manhole Frame and Cover

7. Move your mouse down and to the right to include only the top view of the Manhole Frame, and issue a data point for the opposite corner, 
as shown.
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NOTE: The two points you are selecting are intentionally less than the area needed for the detail. You will adjust this later to encompass 
the proper amount of area around the detail in an upcoming step.

8. Next, you are prompted to enter the view orientation. Move your mouse so that it will index (bold white line) with the X-axis of the 
AccuDraw compass. Issue a data point to fix angle and then issue another data point to accept. 

9. Ensure the following options are set in the Create Drawing dialog:

 Name: Manhole Frame and Cover

 Drawing Seed: Site Plan Details

 Create Sheet Model: Enabled

 Sheets: New

 Annotation Scale: Full Size 1 = 1

 Drawing Boundary: New

 Detail Scale: 1/2” = 1’-0”

 Add to Sheet Index: Disabled

 Open Model: Enabled

10. Click OK.
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The newly created sheet model opens with the Named Boundary referenced, centered onto the sheet. As mentioned, the area of the 
named boundary was deliberately smaller than the area needed to encompass the detail. You will now adjust that named boundary to 
include all the graphics.

11. Open the Models dialog. 

12. Click into the Name field and change the name from MANHOLE FRAME AND COVER to SITE PLAN DETAILS 01.

13. Click into the Sheet Number field and change to 000.

14. Click into the Description field and change this to Site Plan Details Sheet.

15. Bringing you cursor into the view, hover your cursor over the Marker to make the mini-toolbar appear. From here, select the Open Design 
Model icon.

16. The model where you placed the named boundary opens. Make the Element Selection tool active (Home > Selection). Select the Named 
Boundary shape and then select the lower-right handle (blue square). 

17. Drag this handle down and to the right to include all of the detail. Issue a data point to place the handle.
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18. Return to the sheet model by hovering over the Marker. Select Site Plan Details 01 from the drop-down menu and then clicking the Open 
Target icon. 

19. This action returns you back to detail sheet. You will notice that by changing the boundary in the design model, that this has propagated 
to the sheet.

20. Next, right-click and hold to bring up the contextual menu. From here, select Level Off.

21. Issue a data point on the Named Boundary, hence turning off the level. 
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Creating a Drawing Boundary

Traditionally, sheet creation and layout has been a very manual and time consuming process. To overcome this, the 
drawing boundary feature is provided to allow you to quickly and easily define the location of a drawing on a sheet. 
which may contain a drawing. A sheet may be subdivided into several drawing boundaries. The following features are 
covered:

 Moving a Reference

 Predefining an area in an existing sheet model for placement of Named Boundary

 Placing a Named Boundary based on a predefined Drawing Boundary

Use the Reference command to create multiple areas on your Layout.
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1. Continuing in the Site Plan Details.dgn file from the 09 - Composing Sheets folder, open the Level Display dialog (Home > Primary).

2. Turn on the following levels:

 SheetLines_h1

 SheetLines_h2

 SheetLines_h3

 SheetLines_v1

 SheetLines_v3

 SheetLines_v4

By turning these levels on, this graphically provides sections in which to place more details. Before you will place more details, though, 
you will move the first detail that was referenced to the center of the sheet initially.

3. With the Element Selection tool (Home > Selection) active, hover your cursor over the Manhole Frame and Cover detail. Right-click and 
then from the contextual menu select Move Reference.

4. Enter a data point from which to move from and place this into the first section (upper left-most section).

5. Set the active level to DrawingBoundaries via the Level Picker (Home > Attributes) if it is not already set.

Hint: Use the search field and type in, “draw” to truncate the level list.

6. Along the ribbon, from the Detailing ribbon group of the Annotate tab, select Drawing Boundary.
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7. Set the following options in the tools settings window:

 Detailing Symbol Style: Default (No Anno)

 Name: Detail-2

 Drawing Type: Detail

 Method (icon): By 2 Points

8. Following the status bar prompt (lower-left of the MicroStation application), define the first corner of the drawing boundary. This will be the 
upper-left corner of the second section, directly to the right of where the first detail is currently located. Snap to the intersecting lines and 
issue a data point.

9. Next, define the second corner of the drawing boundary by snapping to the intersecting lines in the lower-right of this same section.

10. Then, place the detail symbol by issuing a data point in the middle of this section, along the bottom.

You now designated a specific area on this sheet that can be populated in the future by a named boundary. Notice, as part of the third 
step in creating the drawing boundary, that the detailing symbol is not visible. This is due to a setting/option of the Detailing Symbol style 
used which, in this case, hides the symbol.

You will now place 3 additional drawing boundaries into the remaining open sections.
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11. With the Place Drawing Boundary - By 2 Points tool still active, take note in the tool settings window that the Name has automatically (and 
conveniently) incremented to Detail-3. Following the previous steps, place the drawing boundaries into each remaining open section by 
first snapping to the upper-left, then to the lower-right, and then placing the symbol in the bottom-center.

NOTE: These drawing boundaries were placed into this active dgn file and you will populate these in the next exercise. However, it is 
important to note that it is more advantageous to create drawing boundaries into your seed files and/or Design Libraries. That is, of 
course, dependent on your company’s/organization’s setup. That way, when you create new sheets, based upon your seed selection, the 
drawing boundaries are standardized and already present in the newly created sheet.

This “detail sheet” is a good example of having pre-existing drawing boundaries but another example might be a “plan/profile sheet” with 
drawing boundaries. For instance, divided into to halves -- where the upper half would contain the “plan” and the lower half would contain 
the “profile.”
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Populating Drawing Boundaries

In a previous section, within the detail sheet, you designated areas using the drawing boundary tool. A drawing 
boundary is a predefined area on a sheet model which may contain a drawing. As you saw, the sheet may be 
subdivided into several drawing boundaries.

In this section, you will use the Named Boundary tool to populate these drawing boundaries with additional details. The 
following feature is covered:

 Placing Named Boundaries to populate drawing boundaries
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1. Continuing in the Site Plan Details.dgn file from the 09 - Composing Sheets folder, 

2. From the Models dialog (Home > Primary). make the Concrete Curb model active by double-clicking it.

3. Ensure that the active level is DrawingBoundaries.

4. Make the Place Named Boundary tool (View > Named Boundaries) active.

5. Set the following options in the tools settings window:

 Method: By 2 Points

 Name: CONCRETE CURB

 Mode: Place a Single Named Boundary

 Create Drawing: Enabled

6. Place two opposite corners around the detail, set the orientation of the view to be orthogonal, and then issue a data point to accept.

The Create Drawing dialog opens.



Copyright © 2016 Bentley Systems, Incorporated 26DO NOT DISTRIBUTE - Printing for student use is permitted

7. Ensure the following options are set in the Create Drawing dialog:

 Name: CONCRETE CURB

 Drawing Seed: None

 Create Sheet Model: Enabled

 Sheet: Site Plan Details 01

 Drawing Boundary: Detail-2

 Detail Scale: 3/4” = 1’-0”

 Open Model: Enabled

8. Click OK to place the named boundary.
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9. Open the Models dialog and make the Bollard model active by double-clicking the name.

10. Activate the Place Named Boundary tool and set the following options in the tools settings window:

 Method: By 2 Points

 Name: BOLLARD

11. Like before place the points around the detail and ensure the 
following options are set in the Create Drawing dialog:

 Name: BOLLARD

 Drawing Seed: None

 Create Sheet Model: Enabled

 Sheet: Site Plan Details 01

 Drawing Boundary: Detail-3

 Detail Scale: 3/8” = 1’-0”

 Open Model: Enabled

Note: When you selected Detail-3 from the Drawing Boundaries, 
you may have noticed the absence of Detail-2. This was due to the 
fact that it has an assignment now, and therefore, will no longer be 
an option.

12. Click OK to place the named boundary.

13. Open the Models dialog and make the Accessibility Symbol model active by double-clicking the name.

14. Activate the Place Named Boundary tool and set the following options in the tools settings window:

 Method: By 2 Points

 Name: ACCESSIBILITY SYMBOL
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15. Like before place the points around the detail and ensure the following options are set in the Create Drawing dialog:

 Name: ACCESSIBILTY SYMBOL

 Drawing Seed: None

 Create Sheet Model: Enabled

 Sheet: Site Plan Details 01

 Drawing Boundary: Detail-4

 Detail Scale: 1/2” = 1’-0”

 Open Model: Enabled

16. Click OK to place the named boundary.

17. Open the Models dialog and make the Downspout Connection model active by double-clicking the name.

18. Activate the Place Named Boundary tool and set the following options in the tools settings window:

 Method: By 2 Points

 Name: DOWNSPOUT CONNECTION

19. Like before place the points around the detail and ensure the following options are set in the Create Drawing dialog:

 Name: DOWNSPOUT CONNECTION

 Drawing Seed: None

 Create Sheet Model: Enabled

 Sheet: Site Plan Details 01

 Drawing Boundary: Detail-5
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 Detail Scale: 1/2” = 1’-0”

 Open Model: Enabled

20. Click OK to place the named boundary.

With that, the final detail is place onto the sheet. And as with the rest of the details, it was placed within the drawing boundary that you 
prescribed earlier.

21. Right-click into view and from the contextual menu, select Level Off. Then click onto the named boundary shape for each detail. 
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Attach a Raster Image

Using Raster Manager you can attach raster images of various formats, from monochrome to full color. You can modify 
the location, display order, and various other settings of previously attached raster image files. When a raster 
attachment is modified with Raster Manager, no changes are made to the original file, just to its attachment information 
in the DGN file.

In this section, you will perform a finishing touch to the Cover sheet by placing a raster image for the location map. The 
follow feature is covered:

 Attach a Raster Image

The Reference utility will let you attach images in AutoCAD.



Copyright © 2016 Bentley Systems, Incorporated 31DO NOT DISTRIBUTE - Printing for student use is permitted

1. Open the Cover Sheet.dgn file from the 09 - Composing Sheets folder.

2. Along the ribbon, from the Primary group of the Home tab, click the Attach Tools drop-down arrow and select the Raster Manager.

3. The Raster Manager dialog opens. From here, select the Attach icon.

4. In the Attach Raster Reference dialog, navigate to C:\BentleyCONNECTTraining\WorkSets\MSBasicsCivil\Standards\Data\ and then 
select the Location Map.png

5. Along the bottom of this dialog, disable the setting Place Interactively, enable the Open Settings Dialog, and then click Open.

The Raster Attachment Options dialog opens. The options in this dialog allow you to set various attributes of the raster attachment, such 
as the level it is placed on, the symbology of the raster border, or in which views and which plane it is displayed.

6. From the General panel of the Raster Attachment Options, set the Level to Raster_Ref.

7. In the Display Print panel, ensure that the image will be placed in the Background plane.
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When attaching a raster image to a 2D model, the raster can be placed in different planes.

 Design - The raster shares the same space as design elements and you can use the display priority to define the display order.

 Background - The raster will always be behind any design elements.

 Foreground - The raster will always be in front of any design elements.

8. Click Attach.

Since you disabled the option for Place Interactively, the raster image is placed automatically, based on the image’s own positioning 
information.

9. Zoom out and you will see that the raster is located just below the Border Sheet.
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Manipulate a Raster Image

In the previous section, you attached a raster image of a location map. In this section, you will use standard 
manipulation tools to adjust the size and location of the location map. Then, once this is positioned onto the sheet, you 
will clip the image. The following features are covered:

 Utilizing Standard Manipulate Tools on a Raster Image

 Clipping a boundary of a Raster Image
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1. Continuing in the Cover Sheet.dgn file, make the Scale tool (Home > Manipulate) active.

2. Set the following options in the tools settings window:

 Method: Active Scale

 X Scale: 0.45

 Y Scale: 0.45

 About Element Center: Enabled

3. Identify the raster along the perimeter and then issue a data point to accept the selection.

The raster image is now scaled down. Next, you need to move it inside the shape in the center of the Cover Sheet.

4. Select the Move tool (Home > Manipulate).

5. Press the C on your keyboard. This will invoke the AccuDraw shortcut, Center Snap.

6. Identify the raster along the perimeter.

7. Press the C again on your keyboard.

8. Move your cursor to the square, shape element in the center of the Cover Sheet. Once snapped, issue a data point to move the raster.

The raster image is now positioned correctly onto the sheet. However, as you can see you will need to clip or crop this raster image based 
on the shape element.

9. In the Raster Manager, make sure that you first select the Location Map.png.

10. Next, Along the icon bank of the Raster Manager, select Clip.
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11. Set the following options in the tools settings window:

 Method: Element

 Mode: Clip Boundary

12. There are actually two square shapes in the center of the Cover Sheet. Issue a data point on the inside shape, hence clipping the raster 
image.

13. Save settings (File > Save Settings).
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Sheet Index

A sheet index is a centralized and structured collection of sheets in your project. You may link any sheet model from any 
design file of your project into a sheet index. Now that you are through designing, you will now add the project’s sheets 
to their respective folders. 

 Link sheet models

A similar tool is the Sheet Set Manager in AutoCAD.
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1. Continuing in the Cover Sheet.dgn file, along the ribbon, select the Explorer from the Primary group of the Home tab.

The Explorer dialog builds upon the foundation of the Project Explorer found in earlier editions of MicroStation. In MicroStation 
CONNECT, you can manage the project data using the Explorer dialog. It is a single interface that provides browsing function for files, 
links, items, resources, and sheet indexes.

2. On the Explorer dialog, click the Sheet Index panel.

A sheet index is a centralized and structured collection of sheets in your project. A Sheet Index can be useful in creating a construction 
document set (also called a sheet set or construction set) that contains all the sheets of your project. You may link any sheet model from 
any design file of your project into the sheet index. Sheets may also be organized hierarchically in folders, with the ability to override 
sheet numbering rules for sheets in each folder. You can then manage the properties of all the sheet models within the sheet index 
collectively. Sheet indexes may also be added to print organizer print sets for printing.

3. By default, the sheet index is read only. In the icon bank of the Sheet Index panel, click Open Sheet Index for Edit.
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The sheet index can now be edited. 

4. Right-click on the 03 - Details folder. From the contextual menu, select Properties.

5. In the Properties dialog, review the properties. In particular, the Sheet Number Prefix in the Sheet Numbering Controls panel. The value is 
set for “D-” and therefor, any sheet that is added to this folder will have such a prefix.

6. Back in the Sheet Index, select the 01 - General folder. Review the properties for this folder as well.

Also, take notice of the title block. Here within the title block are text fields. Once this sheet is added to the Index, these text fields will be 
automatically updated.

7. Next, click the Add Sheet icon from the icon bank of the Explorer’s Sheet Index panel.

8. Navigate to C:\BentleyCONNECTTraining\WorkSets\MSBasicsCivil\dgn\09 - Composing Sheets\, select the Cover Sheet.dgn and then 
click Open.
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9. The Add Sheets dialog opens. From here, expand to view the available sheet models by clicking the arrow next to the file path/name. 
Select the Cover Sheet and then click OK. 

Like mentioned, the text fields automatically updated to reflect the properties. In particular, the Prefix “G-”.

10. Next, select the 02 - Plans folder.

11. Click the Add Sheet icon again from the icon bank of the Explorer’s Sheet Index panel. From the 09 - Composing Sheets folder, select the 
Site Development Plan.dgn file and then click Open.

12. From the Add Sheet dialog, select the Site Development Plan (Sheet) and click OK.

13. And then, select the 03 - Details folder.

14. Click the Add Sheet icon once again from the icon bank of the Explorer’s Sheet Index panel. From the 09 - Composing Sheets folder, 
select the Site Plan Details.dgn file and then click Open.
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15. In the Add Sheets dialog, expand to view the available sheet models by clicking the arrow next to the file path/name. Select all three Site 
Plan Details (in sequence) and then click OK. 

16. In the Sheet Index, expand the 03 - Details folder.

17. Double-click the D-01 Site Plan Details 01 sheet model.

18. The sheet model opens. From here, zoom into the lower-right corner of the title block. Take notice of the text fields that have been 
updated to reflect the properties of the sheet index. In particular, the sheet sequence.
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When finished, take note of the numbers within the sheet index. The number next to the project root folder indicates the total number of 
sheets for the set. Beside each folder name, the number shown represents the total number of sheets within that respective folder. And 
within each folder, there are two numbers in brackets next to each sheet. The first number represents the sheet sequence within that 
folder and the second number indicates the overall sequence relative the sheet set. 
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